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System Requirement

The system requirement for Outlook Email Archive is:

Macintosh with MacOs from 8.5 up t0 9.2.1
Microsoft Outlook Express from 5.0 to 5.02

Many thanks to Douglas and Martin for help in the manual.
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Quick Start

Welcome to Qutlook Email Archive (OEA), the simplest and quickest way to
archive your email messages.

Launch Microsoft Outlook Express.

Launch OEA (Outlook Email Archive). A main window appears:

Click on the top-left icon. @
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The folders and subfolders of your Microsoft Outlook program will be
loaded in the popup menu in the same sequence and positions as they are
in your application. At this point select the folder that you want to archive.
Into the last textbox, “Destination folder for Archive” drag the main folder
that will be used for the final destination of your archive.

You can also click on the left icon and the standard dialog box for choosing
a folder will appear.

At this point click “Process” and OEA will start the archiving process and
show you the progress of the operation.

Preface

Outlook Email Archive can archive your email in three different ways:

Archive email and/or attachments in the Finder.

1 - Archive Emails + attachments
2 - Only Emails
3 - Only attachments

Export or append email in a text file that can be read by a text editor or
a word-processing program.

4 - Export new text file
5 - Append to text file

Export or append email in tab-text format that can be imported, for
example, in FileMaker Pro. For this export function a free template is
enclosed in the “Extra” folder in the Outlook Email Archive folder.

6 - Export new tab-text file
7 - Append to tab-text file

Settings 1,2,3 produce produce a Finder-structured-folders archive where
emails and/or attachments are grouped by day (see next pages for more
details).

Settings 4 and 5 produce a long “paper trail” file that can be viewed with a
robust text editor like BBEdit or Text-Edit Plus (SimpleText can read a
maximum file size of 32 KB)

Settings 6 and 7 produce a tab-text file that can be imported into computer
database programs, including one of the best known database programs
for the Macintosh platform, Filemaker Pro.

With the first three kinds of archives OEA can recognize if one email has
been exported. In the Log there is the line “Skipped emails (already
archived)."

When using other kinds of archives, OEA always exports all emails found.
The best solution is to delete email from Outlook Express after it is
archived using the appropriate command in OEA.



Using Outlook Email Archive

After you launch OEA the main window appears.

On the top you can find the Outlook icon. Click on it to load the structure of
folders and subfolders of OQutlook into the popup menu “Source Folder”.
The user can include all subfolders by clicking the checkbox “include
Subfolders”.

The checkbox “All Structure” is for archiving the complete Outlook Express
structure.
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In the Destination box, the user can select the main folder or file
(depending on which Preferences have been chosen).
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About “Include Subfolders” and “All Structure”

Depending on which of the three types of archive the user selects, the
folder and its contents may be treated differently. If the user selects the
type of archive that produces “Finder structured” folders, and if the user
selects one Outlook Express folder without subfolders, then the contents of
this Outlook Express folder will be saved directly into the output folder
destination.

However, when the chosen folder contains subfolders or when

“All Structure” is selected, the complete Outlook Express structure
(including the main folder chosen) will be saved into the output folder
destination.

Remember this for a correct output destination structure if you choose
settings 1, 2 or 3.

Delete Archived Emails

Choosing Delete Archived Emails from File menu (only for registered copy)
will open a window where it is possible to start the process that moves all
previously archived emails to the Outlook folder “Deleted Items”.

The messages are retrieved from the last archived session.

Once the session was been archived, if you want to be able to use this
feature, we strongly reccomand to don’t quit from OEA.

When emails are in the Outlook Express folder “Deleted items” the user
can choose to delete them manually or to activate from Outlook Express
the schedule command “Empty Deleted ltems Folder” on quit.

In the latter case consider that Outlook Express can take a long time (up to
two or three minutes) to delete emails from the internal Microsoft database
(this depends on the number of emails in the “Deleted items” folder).
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Preferences

Before using Outlook Email Archive (OEA), chose Preferences from File
Menu.

The are four tabs: General, Folders, Tab Text and Filters.

Preferences
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Type of Archive (General Preferences)

The first three choices (Emails + attachments - Only emails - Only
Attachments) produce a “Finder Archive”, a structure of folders and
subfolders where the emails are stored by day of the year and time of the
day. For browsing this kind of archive | use and recommend to using
Sherlock (refer to page 12 for more information).

In this example the structure of folders and subfolders of Microsoft
Outlook Express is shown.
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When first using Outlook Email Archive | suggest creating the same

structure of folders and subfolders in the “Finder” that are in Microsoft
Outlook. (but this structure can be created automatically if you set “All
Structure”). Later simply drag and drop the destination folder from the

Finder to the “Destination folder for Archive” textbox in OEA’s main palette.

(See page 4 for more info...)

The resulting Finder archive will be like the one in the following example:
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All emails are grouped by day. In the example, the number (089) before the
date 29 March 2000 indicates the progressive number of the day of the
year (from 1 to 365 or 366); inside this folder, you will find all emails
received that day with the “Outlook ID Message” and the email (received or
sent) time. At this level OEA saves the email + attachments.

The other two choices from the popup menu are for archiving only emails
or only attachments.

Emails are saved with the creator chosen. Attachments are saved in the
original format (Stuffit, Compact Pro, native files...).

For browsing your email archive you can use Apple Sherlock Technology
and search inside the selected folder previously indexed for search in
the contents (refer to page 12 for more information).



Export new text file - Append to text file...

When the command “Export new text file” is selected, a blank destination
file is created (click on the icon file on main OEA window) and then filled
with the entire contents of the email messages:

[0 ——————— March 200 =—H 3

Ernail IC: 3280

Mizrosaoft Folder : From Macromedia

Ernail Class: Incorming Message

From: John Smith jsrith@rnacromedia.comn

To: capste@rnac.com, Frank Foss fross@apple com
Ci: Mark Moble rark.noble@asl.com

B

Sent Date: Friday, March 23, 2001 3:22:00 PM
Received Date : Saturday, March 24, 2001 1:54:13 PM
Attachrments : Flash 50523

Subject. Beta Yersion of Flazh 5.0

Hello Stewve,

thiz nurnber will also route to iy phone mail.

My biggest concern iz time zone differences.

Right now there is @ hours time differences between Santa Monica armd
rmost cities in Europe. If you happen to have daylight saving time, the time
differences is 10 hours.

By

John Smith

S]]

When the command “Append to text file...” is chosen, OEA appends the
email messages to the end of messages in an existing file.

Export new tah-text file - append to tab-text file

The command Export tab-text file is for generating a text file useful for
importing data into a database like, for example, FileMaker Pro.

A free template for FileMaker Pro 5 is included (in the folder “Extra”) and is
“open.” Users can change or modify the scripting and layout.

Before importing data into FileMaker it is important to select from the
popup menu of FileMaker Pro the command “Tab-Separated Text” as in
the following example:
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The following fields are exported:

Email ID: internal reference email ID of Microsoft DB

Microsoft Folder: name of the folder or sub-folder where email is located.
Email Class: class of message (incoming message or outgoing message)
From: the sender of email (display name and email).

To: list of addresses (display name and email separated by commas).

Cc: list of addresses (display name and email separated by commas).
Bec: list of addresses (display name and email separated by commas).
Sent Date: the sent date of email.

Sent Time: the sent time of email.

Received Date: the received date of email.

Received Time: the received time of email.

Attachments: the list of attachments (separated by commas).

Subject: the subject of email.

Body: the content of email.

i B

/4|>|

4




When a new tab-text file is created, the first record is the list of the labels
fields (even if the import into FM Pro is very simple this is a facility for
matching the fields between the file and the FM Pro Archive).

Import Field Mapping
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Bady Body
Buffer
Sent Time
Received Time
Rec_number
Rec_found
Rec_tot
HMessage

RFecord 1 of 2521

E] Scan Data @

Import Action

Lefine Fields...

Hap Legend

=% Import data
@ [Don't import
4= Match fields
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Importing data from existing FM Pro archives

Because new fields have been added (starting from OEA 1.5), users that
want transfer data from a previous archive of Filemaker Pro to a new
template “Email DB” must import the data following the example:

Import Field Mapping
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Attachments

Rec_found
Rec_number

Hicrosoft Folder
Received Date

Sent Date

Sent Time

Sent Time Seconds
Received Time
Received Time Seconds

Email Class

Important Note:
The length of FileMaker Pro text fields is limited to 64 KB.

Append to tab-text file...

When the command “Append to tab-text file...” is chosen, OEA appends
the email messages to the end of the of file.
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About FileMaker Pro Template

The templates inside the folder “Extra” can be used for archiving all emails
exported with the function “Export tab-text file”.

The templates are in FileMaker Pro, version 5.

Because FM Pro can manage dates in two different ways when the user
enters data from the keyboard (as mm-dd-yyy or dd-mm-yyyy, according
to the language and settings of your MacOQs) it is necessary before using
the template to follow these steps:

You need this only the first time to initialize correctly the FM Pro document.

1. Open the template in FileMaker Pro.

2. Choose from File menu the command “Save a Copy As...”

3. Rename the file and choose from the popup menu the option “clone (no
records)”

This command changes the internal setting of the template concerning the
entry of some values like “Date”.

4. Close and open the new saved template.

5. Create a new record and type in the field “Date” the “Christmas of
December 2000” date as you usually type in Filemaker Pro (according to
the language and settings of your MacOs).

6. Press enter.

1. Because the field date is formatted to show the date as “dd Month
yyyy,” if you see 25 December 2000 (in your language), all is OK.

8. Delete this record and import the data exported from OEA (please check
the exporting settings in the “Preferences” window.

Creator for saved files (General Preferences)

All text files saved (including Log, Log Errors and all emails) will be saved
with the creator choosen.
The list of creator choices is as follows:

SimpleText
BBEdit

Tex-Edit Plus
Applellorks
Microsoft Word
Alpha

About Sent-Received date of Emails

Starting from version 2.3, OEA handles automatically the sent/received date
of emails getting the class of email (incoming message or outgoing
message).

This means that if one email is “incoming”, OEA will use the Received date
of email to generate the “Finder Structured Archive”, otherwise OEA will
use the send date (for outgoing messages).

When the user chooses to export all message as a “new text file” or to
export the messages to a tab-text file, OEA writes both the sent and
received dates and times on file.

Important Note:

If you import emails from Microsoft Outlook Express 4.5 to Outlook
Express 5, the received dates are reset at the moment of the operation.
To check on this “Microsoft Bug” you can include a “Received Date
column” from the View menu in Microsoft Outlook Express.



Date format for Finder Archive (Folder Prefs)

Preferences

,-_" General E,-" Fu:uld-e-r's\_,-"rTab TEKtVF”tEFE\

[rate forrat for Finder archive

| (342) 8 December 2081 4]

You can set the date format for the folders (of day) created with the
following types of archives:

Emails + attachments
Only Emails
Only attachments

by choosing from the popup menu one of the following five settings:

* [342) 8 December 2881

(342) 83 December 2881
(342) 88 Dec 2881
2881-12-88 (yyyy-mm-dd)
12-88-28081 (mm-dd-yyyy)
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Date format for tab-text file (Tab Text Prefs)

Preferences

),-"r Generalv Falders VTab Text VFiIter’s \

[rate forrat for tab text file

[Munth—l]ag—'u'ear i]

Cancel I 114 I

In the popup menu “Date format for tab-text file” choose the correct
setting for your FileMaker Pro archive. Two settings are available:

+ Month-Day-Year
Day-Month-Year
Month-Day-Year (USA format)
Day-Month-Year (Euro - Rest of the World format)

Example:

Choosing the first setting (USA) results in the email date 14 May 2000,
being written to tab-text file as 5-14-2000.

Choosing the second setting (Euro) results in the date being written as
14-5-2000.

This is important for correct import of data into FileMaker Pro archives.



Log Filters Preferences

Every time Outlook Email Archive processes a folder, it writes a Log When the checkbox “By Date” is selected OEA processes only emails older
file. The Log file is a text file showing the user the history of than the value specified in the textbox.
tasks executed by OEA. It is possible to see the log by choosing “Show You can for example process all emails older than 30 days and in this way
Log” from the File menu of Qutlook Email Archive. keep in the Outlook Express DB only the emails of the last 30 days.
To disable this feature and archive all emails in the selected folder/structure
0e—m———1ug e simply disable the check box and click OK.

Start process: Friday, January 12, 2001 02:12:07 P
Preferences

Twpe of Archive: Emails + attachrments

Drate: Friday, January 12, 2001 02:12:07 PM

Archived falder | Personal .
Murnber of messages found : 0 J.-"r General -‘l.,u.-"r Folder=s v Tab Text \_..-"r Filters

Meszages archived: 0
Skipped emails Calready archived): O

E By Date
Drate: Friday, January 12, 2001 02:13:05 PM
Archived folder : Friends Process emails older than | 38 | days
Murnbet of messages found : 224
Meszages archived: 224

Skipped emails Calready archived): O

Date: Friday, January 12, 2001 02:13 456 PM
Archived folder : eBook

Murnbet of messages found : 192

Meszages archived: 192

Skipped emails Calready archived): O

Drate: Friday, January 12, 2001 02:14:07 PM
Archived folder : Quark

Murnbet of messages found : 68

Meszages archived ! &2

Skipped emails Calready archived): O

Drate: Friday, January 12, 2001 02:14:20 PM
Archived folder : Technical
Murnbet of messages found : 52

Meszages archived: 32 Cancel ] || 1] 4 ]l
Skipped emails Calready archived): O

End process: Friday, January 12, 2001 02:14:20 PM

Total process time: 00:02:13

TR IR TR TR TR TR TR T T T A o A DA O o A O DA R A R R
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Using Sherlock to browse archives

The internal Apple Search Engine called Sherlock, can perform search
functions inside the contents of files. This means that it is possible (after
indexing) to search every kind of information on archives with
Finder-structured folders created with Outlook Email Archive.

| suggest storing your archive as a Disk image created with Apple Disk
copy or on media like Jaz, Zip or on a dedicated partition on your Hard
Disk. This is because the process of indexing is related to the entire disk
and if you put your archive on your Hard Disk you need to index the entire
disk.

Using contextual menu is also possible to index only selected folders (or
main folder that contains all archive, without create separate archive on
dedicated disk)

Searching for some emails (using the “find by content” feature) is very fast
on the indexed disks. Sherlock stores the invisible index file inside the disk
itself, thus when you copy the disk image file (or take your Jaz, Zip,
PocketDrive), you will copy the index automatically and you will not have to
re-index your data again.

In this way, your archive is independent and you can copy it to another
Mac and perform every kind of searching... using Apple Sherlock.

Of course, you have to update your Sherlock index every time you perform
a new “Archiving” from OEA but this is a very fast procedure (and this
operation can be scheduled at predefined intervals).

After you have exported data from your Outlook with OEA using one of the
first three kinds of archives you have created a Finder-structured-folders
archive. | think this kind of archive is best for History archives. By History |
mean that you don’t need to have thousands of Outlook emails online,
because when you want to search one specific email you can do this using
the quickest possible way: Sherlock.

Index your archive by following the instructions in the Apple Help.

After having done this, you can ask to Sherlock to find every email that
contains specific words. In my Examples | have created a query for
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searching every email that contains the words Quark and ATM.

Because Sherlock performs the search using the term OR between search
words, the results are shown by relevances: long progress bars mean that
Sherlock has found all the words requested. Short bars mean that emails
contains not all words requested. You can perform many types of queries
like:

Search all email sent from John Smith regarding Quark and ATM or
Search all email sent from John Smith in December.

You can also perform the search only on some folders of your archive:
simply drag onto the Sherlock window the folder (in my example Sent)
where you want execute the searching (you can drag and drop more than
one folder) and perform the search on every folder or volume (like disks)
you want.



Sherlock Examples
Query with “Kodak” and “dcs” and “tiff” on entire disk “My Archive”.
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Result of query (long progress bars mean that Sherlock has found all the
words requested).

[—— Yon, B B1, 2000, 1612

— | Sty Dot B0, 20800, N6:IT

B il e b =3 SempheTavt ot dcmmmet  Som, fun 11, 2000, 16 18

E Vi ki e wR R g liva = dwmpieTen | St deiamanl  Sen See 11, 2000, 168
e |6lp Brgam = S, B B1, D000, 1818 EI
=] Fe- b newpsh e g il - Ben, fa W1, 2000, V616 fa]

o T ki
B} corvinposnnzs
0} Pechani
B (34m 0dsap 2000
B) (%8035 Tiss ) 1 57 25
E: PRy T ee——T]

Query with “Quark” and “ATM” on folder “Sent ltems” of disk “My Archive”.
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Result of query (long progress bars mean that Sherlock has found all the
words requested).
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Tips for Microsoft Qutlook

Microsoft Qutlook creates a folder for each user profile.

All of these folders are placed inside the “Outlook Express 5.02:1dentities”
folder.

For instance, we have three users as well as three main folders: me, my
wife and my son. Inside each folder is the same structure: all emails are
stored in a single file named “Messages” and the Microsoft Database is
stored in a file called “Database”.

Creating new messages in Microsoft Qutlook Express increases the size of
these two files. When messages are deleted, Microsoft Outlook DOES NOT
reduce the size of these two files.

To reduce this free and wasted space, you have to compact the two files
using the following procedure:

Launch Microsoft Outlook Express holding down the option-key just before
the splash screen appears and until you see the following dialog.

Click on the button “Rebuild”.

Outiook Express

f ¥Would vou like to compact the database?

Yes

(o]
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After some minutes, at the end of this task, you will see a dialog which
notifies you that all the files have been compacted successfully.

Now, you can check to see how much smaller the files “Message” and
“Database” are in the Finder.

Your database was rehuilt, the old database
and messages file have been renamed "0ld
Database™ and "0ld Messages™ respectively.

They can he thrown away.

Be sure that you have enough space on your Hard Disk, because Microsoft
Outlook Express used to duplicate and save the old and uncompacted files
naming them “Old Message” and “Old Database” respectively.

So, at the end of this task you should trash these old files.



Tips for Qutlook Email Archive

To obtain the best performance from OEA, we suggest you disable antivirus
programs (like Virex) by switching them off from their Control Panel, and if
you opened “FileMaker Pro”, quit it (it used to make the machine too
busy). The performances are increased also if you switch off Appletalk.
You can store the “OEA Finder Archive” in a Disk Image you created before
using utilities like “Apple Disk Copy”. Launch the “Apple Disk Copy”
program and select from the “Image” menu the command “Create New
Image”. A dialog will appear. Choose a name and size for your new “Disk”.

Image

Mount Image... HEM

Create New Image... :
Create Image from Folder... 31
Create Image from Disk... #1

Convert Image... K

Sawe disk imaae as;

[ Macintush 1D =] oo @]
Bt Madified | &

H Oullesk Fxpresa 5 1%=00=2000
il Syatern Falder 02 06~ 2000
i LHilikea Nl

LT Ihrrhh.rl- o Vimar Hiimig | | H!"Hl:i J
Forrmeal: Head s rile ~
Siee: | 160ME |

[ Mdommt bmage A Digi%agn™ Signature:

= fero blacks

[+ [ cance [m'

Concerning the size you should assign to your disk: you should know that
the data extracted from Microsoft Outlook by OEA are

non-encoded, therefore the OEA data will use less space on the disk than
Microsoft Outlook did.

Click on the “Save” button and after a few seconds click on the “Erase”
button. The disk will be created and shown on your desktop.

Bl

Initialize disk image "Archive of Year
2000.0muog™;

Archive of Year 2000

Name:

Format: [ Mac 05 Standard 160 MB i]

Switch to the OEA application and choose the new disk as the destination
disk/folder.

Tips: Using contextual menu is also possible to index only selected
folders (or main folder that contains all archive, without create separate
archive on dedicated disk).

Help

Open
Move To Trash

Get Info

Label

Duplicate

Make Alias

Add To Favorites

v

Index selection...

Attach a Folder Action...




FAQ (Frequently Asked Questions)

Q: Will the registration be valid for updates of OEA?
A: Yes, the registration will be valid for all the future updates of OEA under
MacOs (not Os X).

Q: | can’t decompress the software downloaded.

A: You have to unstuff the file with Stuffit Expander 5.5 or higher.

Using previous versions of Stuffit Expander could cause bad unstuffing.
Download last version of Stuffit Expander from:
http://www.aladdinsys.com/downloads/trips/expmacsit.html

Q: Where should I fill the registration code?

A: You don’t have to fill any registration field. Simply place the file
“Registration Code” into the OEA folder. That’s all. Then launch your OEA
application and you will see your name on the splash screen.

Please keep in mind that you don’t have to modify in any case the content
of this file, nor its file name.

Q: | launch OEA but after the splash screen, the main window does not
appear. Why?

A: This can occurs when using 0S 9.1. Be sure that all extensions related
to “Security Library” are enabled; otherwise OEA cannot work properly.

Q: Should | increase the memory assigned to OEA?
A: No, you don’t need. Instead, in case of thousands of emails, increase
the Outlook Express partition memory up to 20-25 MB.

Q: Is OEA compatible with OS X, or does OEA run under Classic mode in
the OS X environment?

A: At the moment, OEA doesn't work in the OS X environment, even in
Classic mode (0S 9.x). However, OEA can be used with the "normal" Mac
0S in any version from 8.5 t0 9.2.1.

Q: When | launch OEA a display dialog appears and asks me to locate
Outlook Express.

A: Ensure that the name of your Microsoft Outlook application is exactly
“Outlook Express”. If the name has been changed for any reason, OEA will
be unable to find Outlook Express.

16

If OEA continues to ask you for Qutlook Express:

Launch Outlook Express FIRST and OEA after that.

If this doesn't solve the problem, and if you are using Mac OS 9.x, place an
alias of “Outlook Express” in the Scripting Additions folder (the name of the
alias must be exactly “Outlook Express”). If you use a version of Mac 0S
older than version 9, place the alias of “Outlook Express” in the OEA folder.
In both cases the name of the alias must be exactly “Outlook Express”.



History Version

2.3.5-2.3.6

Tested compatibility with new Mac Os 9.2.1.

The log now reports the number of emails skipped when the option to filter
by date is selected in the preferences panel.

Improved checks for corrupted email during the archiving process.

Fixed some alert messages.

Fixes and changes in the PDF manual.

2.3 - 2.3 Beta

At the request of users OEA now detects the class of email (incoming or
outgoing) and handles the received/sent date automatically.

The popup menu related to the received/sent date has been removed from
the Preferences area.

OEA now writes additional fields when using text file or tab-text file.

The new fields are: Email ID, Email Class (incoming message or outgoing
message) Sent and Received date, Sent and Received time.

When a new tab-text file is created, the first record is the list of the labels
fields (even if the import into FM Pro is very simple this facilitates
matching the fields between the file and the FM Pro archive).

The template of FileMaker Pro is now called Email DB, is available as
"Freeware", and is completely modifiable; It is now available in OEA
package only for FileMaker Pro 5.

Email DB has been restyled: new interface, new fields added and new
features (to locate immediately all emails that contain some kind of
information).

Like all previous versions of OEA, the "Registration Code" is valid for all
future updates.

The manual has been extended.

2.2

The new feature “filter”, found in the preference area, allows you to
process email older than a certain date.

Trapped bug relating to the names of folders in Outlook Express structure
longer than 31 characters.

Manual revised and FAQ page added.
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2.1

Improved compatibility with OS 9.1. Added the feature to remove
automatically all archived messages: the removed messages are moved to
the Deleted Items folder of Outlook. Fixed bug that prevented correct
startup of OEA on some versions of MacOS. (read the manual about
requirement with MacOs 9.1).Trapped bug if folder names of Outlook
contain “:” colon characters. Unregistered version can now manage 12
emails for each session. Manual has been modified and extended.

2.0

New interface.

Outlook Email Archive (OEA) is now compatible with the new MacOs 9.1

Is now possible to archive the subfolders or all structure in one session.

All the preferences are now saved.

Added support for saving files with the creator type for Alpha Text Editor.
The PDF manual has been revised. Sherlock section is better explained with
screen shot and examples.

1.9.9
The emails are now saved with the “Creator Type” chosen.
Added the “Append to tab-text file” feature.

1.9.5

User can now define the name and location of file created with the
functions “Export new text file” and “Export tab-text file”.

The routine “Export tab-text file” now removes possible TAB characters
from the fields From, To, Cc, Bcc, Attachments and Subject.

Minor internal optimization and changes.

Update of manual.pdf.

1.9

The routine “Export tab-text file” has been rewritten: now is 40% faster
(especially with emails with multiple addresses).

The date is now exported (in the “Export tab-text file”) as “real date” and
not as “text” date.

In case of errors OEA will not stop the execution but instead will write a
log file inside the OEA folder called “OEA Errors Log”.

The file menu is now disabled during the archiving process.

The textbox “Destination file for Archive:” is now disabled during the
archiving process.



The window “Report” has been redefined and now includes a count of the
number of errors.

OEA now checks, before starting the archiving process, to determine if
FileMaker Pro is open.

Numerous modifications have been made to the FileMaker Pro template
“OEA Email DB” (now converted to FM Pro 5).

A free utility is enclosed in folder “Extra” for updating existing data
(generated with OEA before version 1.9) concerning the “date” in FM Pro.

1.8

Added the “skip emails” feature. There are three new check-boxes in the
Preferences area:

* Unread Emails * Flagged Emails * Edited Emails

The user can choose the destination folder/disk when archiving using
“Export new text file” and “Export tab-text file”.

The user can also archive the data using the MM-DD-YYYY date format
(see the Preferences).

In the unregistered version the user can process 9 emails (instead of
previous 6)

The manual.pdf has been updated with tips and suggestions for better use
of OEA and optimization of Microsoft Outlook Express.

1.7

Added window “Log” where OEA reports all the tasks executed.

Added four kinds of settings for date format in the window “Preferences”.
Added support for AppleWorks in the section “Creator Type”.

1.6

Added support for exporting with the functions “Export new text file -
Append to text file - Export tab-text” addresses related to “To”, “Cc”, Bec”.
Addresses are exported with display name and email address (e.g. John
Smith jsmith@aol.com).

Multiple addresses are supported.

Enhanced info during export progress.

Rewritten “Get info” routine. Now the progress bar is shown.

Minor changes of report window.

Optimized code.
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1.5 Beta

Added support for exporting emails in tab-text format for quick importing
into FileMaker Pro (included is a free template).

OEA now supports export/append for long email messages (more than 32
Kb). Now the structure of folders and subfolders loaded from OEA in the
popup menu is in the same sequence as Microsoft Outlook Express
(including indentations).

Fixed the creator of Microsoft Word for export/append functions.

Fixed the received/sent date for export/append and export tab-text
functions.

Added “Preferences” window.

More than 40% of the code rewritten and cleaned.

For unregistered version user can process six emails (instead of previous 3).
Minor changes of the user interface.

1.4

Compatible with the last version of Microsoft Outlook Express 5.02.

Added support for generating a export TXT file with a creator of one of the
following applications (Teach Text, BBEdit, Tex-Edit Plus, MS Word);
choose from OEA menu the command “Creator Type for Export” and click
on icon.

During the archiving process all popup and textbox menus are now disabled.
Added the name or names of attachments in the “Export TXT file” process.
When the user chooses from the popup menu a folder, the number of
emails are now shown in the left bottom corner of the OEA window.
Changed the display dialog about the export file.

Fixed a bug in the popup “Archive using” introduced in the 1.3 beta.

1.3 Beta

Added support for exporting all emails in one TXT file that can be viewed
with a text editor like BBEdit or Tex-Edit Plus.

User can append emails to an existing file or create automatically a new
one for each session.

Added support for exporting only attachments.

New Finder icon.



1.2

OEA now reads and supports the entire structure of folders and subfolders
in Microsoft Outlook Express without limiting levels. User can now chose
subfolder without switching between the programs.

Added popup menu for archiving emails based on received date or sent date.
Added popup for archiving email + attachment or email only. During the
archiving process the number of emails exported are now shown (e.g.
100/650).

In report window OEA now shows the elapsed time for performing the
operation.

Added message in report window when user deletes email (moves emails
in folder Deleted Items).

The drag-over-destination-folder textbox now performs controls. Rewrote
and optimized routines.

Improved speed.

1.1

New “Report” window that informs the user about: total number of emails
found, emails archived, and emails skipped (because already archived).
Position of main window of OEA is now remembered at the next relaunch.
User can drag the destination folder over the icon or textbox of destination
folder (drag & drop).

User can now interrupt the archiving process pressing command-shift-
period.

OEA now check when the user presses button “archive” to see if Microsoft
Outlook Express in open.

Fixed bug that causes OEA report an error if user doesn’t select a
destination folder. Added button “Delete Emails” for moving all emails from
selected folder to folder “Deleted Items” in Microsoft OE.

Optimized code.

1.0
[nitial Release.
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About Registration and Pricing:
Outlook Email Archive has the following pricing:
single user license, $15 per user (US Dollars)

A Site License costs $200 and covers all locations for your organization
within a 160 kilometer (100 miles) radius of your site.

About Registration:

Paying for the Outlook Email Archive is fairly simple.

There are two methods.

On the Web (quick, easy and secure payment on-line) and by “Register
application (off-line).

To register on the web:

Go to the web page http://order.kagi.com/?V8B

1 - Fill the form with your name, email, address, and how many copies you
want.

2 - Click on the button “Continue” and it will appear the invoice form.

3 - Fill the fields regarding your Credit-Card datas and then click on the
button “Purchase”. That's all.

If your browser supports, you can switch on SSL secure payment form
(it's the internet international standard secure form of payment).

Your invoice will be processed in 24 hours. Therefore, you will receive by
me via Email a little text file “Registration Code” to put inside the folder
“Outlook Email Archive”

”»

To register off-line by the “Register” application:

Launch the “Register” application, enter your name, email address and
number of single user licenses or other licenses you desire.

Save or copy or print the data from the Register program and send the
data and payment to Kagi.

Kagi handles my payment processing.

See the end of this document for more specific payment information.
The fastest way (round 1-2 days) is to save the invoice to a text file,
choosing “via email,” and therefore send that text file via email as
attachment to sales@kagi.com. You can also open the invoice text file with
an editor (e.g. SimpleText) selects all the text, copy and paste into the
email so as it is (without any changement). Don't forget to include your
email address. We need to send to you the Registration Code by email.



Once your message is received by Kagi, you will receive (in round 1-2
days) by me via Email a little text file “Registration Code” to put inside the
folder “Outlook Email Archive”.

Detailed Payment Info:

If paying with Credit Card or First Virtual, you can email or fax the data to
Kagi. Their email address is sales@kagi.com and their fax number is +1
510 652-6589. You can either Copy the data from Register and paste into
the body of an email message, or you can Save the data to a file and you
can attach that file to email message. There is no need to compress the
data file; it's already pretty small. If you have a fax modem, just Print the
data to the Kagi fax number.

Payments sent via email are processed within 1 to 2 days. You will receive
an email acknowledgement when it is processed. Payments sent via fax
take up to 10 days and if you provide a correct internet email address you
will receive an email acknowledgement.

If you are paying with Cash or USD Cheque you should print the data using
the Register application and send it to the address shown on the form,
which is:

Kagi

1442-A Walnut Street #392-V8B

Berkeley, California 94709-1405

USA

You can pay with a wide variety of cash from different countries but at
present if you pay via cheque, it must be a cheque drawn in US Dollars.
Kagi cannot accept cheques in other currencies.

If you have a purchasing department, you can enter all the data into the
Register program and then select “Invoice” as your payment method.

Print three copies of the form and send it to your accounts payable people.
You might want to highlight the line that mentions that they must include a
copy of the form with their payment.

Kagi cannot invoice your company, you need to act on my behalf and
generate the invoice and handle all the paperwork on your end.

Please do not fax or email payment forms that indicate Gash, Check or
Invoice as the payment method. As far as we know, there is still no
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technology to transfer physical objects via fax or email and without the
payment, the form cannot be processed.

Payments send via postal mail take time to reach Kagi and then up to 10
days for processing. Again, if you include a correct email address, you will
hear from Kagi when the form is processed.

For any information about the software of for notify me bugs or enhancement:
Email: capste@kagi.com

Web Site: http://digilander.iol.it/capste/

For further information about the payment:

Kagi - Email: sales@kagi.com Web Site: http://www.kagi.com



